
Copyright DASSAULT SYSTEMES 2002 1

CATIA
Part Design Advanced

CATIA Training 
Foils

Version 5 Release 8
January 2002

EDU-CAT-E-PDG-AF-V5R8



Copyright DASSAULT SYSTEMES 2002 2

0.5 day

Course Presentation

Objectives of the course
In this course you will complete the knowledge acquired in the CATIA Part Design 
Fundamentals course

Targeted audience
New CATIA V5 users

Prerequisites
CATIA Part Design
Fundamentals course



Copyright DASSAULT SYSTEMES 2002 3

Table of Contents (1/2)

1. Advanced Tools p.5
Holes/Pockets/Pads not normal to sketch plane p.6
Creating Grooves p.9
Creating Ribs and Slots p.16
Creating Stiffeners p.27
Creating Lofts p32
3D Wireframe p.67
Surface Based Features p.73
Advanced Draft p.80
Thickness p.95
Using Transformations p.97
3D Constraints p.103
Local Axis p.108
Annotation p.116
Analysis p.127



Copyright DASSAULT SYSTEMES 2002 4

Table of Contents (2/2)

1. Part Management p.137
Measure, Mean Dimensions, Scan, Parents-Children p.138
Cut, Paste, Isolate, Break p.152
Inserting and Managing Bodies p.159
Multi-Model Links p.182
Scaling p.194



Copyright DASSAULT SYSTEMES 2002 5

Advanced Tools

You will learn how to create and use other tools of Sketch-Based, Surface-
Based and Dress-up Features. You will also learn tools of Transformations, 
3D Constraints, Local Axis and Annotation.

Holes/Pockets/Pads not Normal to Sketch Plane
Creating Grooves
Creating Ribs and Slots
Creating Stiffeners
Creating Lofts
3D Wireframe Elements
Surface-Based Features
Thickness
Using Transformation
3D Constraints
Local Axis
Annotation
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You will learn how to create Holes, Pockets or Pads with 
their direction not perpendicular to their sketch 

Holes/Pockets/Pads not Normal to Sketch Plane

•Defining a direction
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Some Key Points:

•When creating a hole, a pocket or a pad, by 
default you get a result perpendicular to the 
sketch you have selected to get these features
•It is possible to define another direction by 
specifying a direction in the direction field
•The selected direction must not be in a plane 
parallel to the sketch plane nor in the same 
plane

What are Holes/Pockets/Pads not Normal to Sketch Plane ?
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Holes/Pockets/Pads not Normal to Sketch Plane

1
If a Pad or Pocket, select 
Profile sketch to be used 2

De-Select 
“Normal to 
Sketch”  
and select 
reference

3 For this geometry, modify definition 
to include type “Up to Plane” and 
select 

Changes 
extrusion 
direction

4

Select the appropriate 
icon

5 Select limit 
surface on part 

You get: 
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You will learn how to create grooves 

Creating Grooves

•Material removing according to a revolution body
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Creating Grooves

4 Select OK

2
Select the 
Groove icon3 Define the limits of the 

groove
Select the profile to be used 
for the groove (the sketch 
must contains an axis) 

3

You get:
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Groove : 3d Line axis

Select the Groove 
icon1 2

Select the 
profile

When creating a groove, it is possible to use a 3d line or a 
sketched line not included in the sketch of the profile as the 
rotation axis

3 Select the Axis field 
in the dialog box

4 Select the 3d line as the 
rotation axis

You can modify the Limits 
parameters then select OK, you 
get:

5
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Groove : Reverse Side
The Reverse Side button applies for open profiles only. This option lets 
you choose which side of the profile is to be extruded

Select the Groove icon1 Select the open sketch2

Modify the Groove Limit 
Angles

3

Select the arrow to reverse the groove side (or 
click the Reverse Side button in the dialog box)

4

Select OK in the dialog box5

You get:
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Additional Information (1/3)
You can use sub-elements of a sketch to create grooves, like for 
pads or pockets
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Additional Information 
(2/3)You can create Grooves from sketches including several closed 
profiles. These profiles must not intersect
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Additional Information 
(3/3)If no sketches have been created when activating the Groove icon, you can access 
to the sketcher by selecting the Sketcher icon in the dialog box. When you have 
completed the sketch, you can leave the sketcher then you will return to the Groove 
creation

Select the Sketcher 
icon in the dialog box 
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In this lesson we will learn how to create the sketch based 
features known as Ribs and Slots

Creating Ribs and Slots

•Creating Ribs
•Creating Slots
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A Rib is a profile swept along an open or closed 
Center Curve to create a 3D feature

What is a Rib ?

The profile can be swept along an open or a closed 
center curve to create the feature

The center curve does not have to extend to the end, 
Merge Ends can be used to extend or shorten the rib 
to its proper wall

The Profile of the Rib can be controlled by simply 
using one of the 3 choices under the Profile control 
section of the window
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A slot is a profile that is swept along an open or 
closed Center Curve to remove material from a solid

What is a Slot ?

The profile can be swept along an open or a closed 
center curve to remove the material

The center curve does not have to extend to the end, 
Merge Ends can be used to extend or shorten the 
slot to its proper wall

The Profile of the Slot can be controlled by simply 
using one of the 3 choices under the Profile control 
section of the window
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You will find Ribs useful when you need to sweep 
profiles from one surface to another

When Should we Use Ribs and Slots ?

Ribs and Slots will also be useful to create complex 
walls of parts that have many details in them. Here 
you can control your complexity in one sketch and 
not have many small sketches or geometric features 
to work with

Slots and Ribs can be created on Planar as well as 
3D Center Curves

Also a Rib can be used to create a pipe by sweeping 
a profile along a center curve



Copyright DASSAULT SYSTEMES 2002 20

Creating a Simple Rib

1 Select the Rib icon

2

Select the 3D Center 
Curve3

Select Pulling direction 
and then select the 
indicated surface

Select the Profile to 
be swept 

4

The Rib is displayed, select OK to 
create the Rib

5

The 3 Dimensional curve was 
created in the Wire Frame 
workbench
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Creating a Slot

1 Select the Slot icon

2

Select the Center Curve 
to Sweep around3

The Slot is previewed and in this 
case the Profile Control is left at 
Keep Angle.  Select OK to create 
the Rib 

Select the Profile to 
be swept 

4

A Sketch for the Center Curve and 
the profile must exist prior to the 
icon being available for selection

The depth of the profile must be equal to or less 
than the radius of the Center Curve
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Additional Information 
(1/5)
Capability to edit the profile and center curve 
sketches during rib or slot creation or edition

Access to to the 
sketcher for the 
profile

Access to to the 
sketcher for the 
center curve
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Additional Information 
(2/5)
You can use sub-elements of a sketch to create 
ribs, like for pads or pockets
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Additional Information 
(3/5)
You can use sub-elements of a sketch to create 
slots, like for pads or pockets
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Additional Information 
(4/5)
You can create Ribs and Slots from sketches including several closed profiles. 
These profiles must not intersect

Rib Slot
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Additional Information 
(5/5)
If no sketches have been created when activating the Rib or Slot icon, you can 
access to the sketcher by selecting the Sketcher icon. When you have 
completed the sketch, you can leave the sketcher then you will return to the 
Rib or Slot creation

Select the Sketcher 
icon in the dialog box You could have use the 

same method to define 
the Center curve 
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In this lesson we will learn how to create the sketch based 
features known as Stiffeners

Creating Stiffeners

•Creating a Stiffener
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A Stiffener is a brace or rib that is added to a wall or 
a stand-off to add strength to the wall or stand-off 
and thus prevent breakage.  It is commonly found 
on molded plastic parts or castings

What is a Stiffener ?

These two arrows are used to 
control the width of the part, it can 
be either symmetrical or all on one 
side or the other

The other arrow is used to 
control the direction of the 
rib

As with most features 
you can now access 
the sketch directly by 
selecting this button
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 They can be used when you have a thin wall that 
you want to be more rigid without increasing the 
thickness of the wall

When Should we Use  Stiffener ?

They can also be used when you have tall objects that are 
used to locate or support other objects and you want to 
prevent them from breaking off the surface they are 
attached to
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Creating Stiffeners 

1 Select the Stiffener Icon 
2

 Key in the Thickness of the 
Stiffener3

If the direction is correct select 
OK to create the Stiffener

Make sure the sketch is 
highlighted 

4

You will find that in many cases need to add a small 
line segment on to the top of the angled line used to 
create your stiffener. This allows for a coincidence 
constraint to be created between the rib and the part
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Additional 
Information
You can use sub-elements of a sketch to create 
stiffeners, like for pads or pockets
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Creating Lofts

You will learn how to create Lofts and Removed Lofts

Creating a Simple Loft
Remove Lofts
Coupling
Closing Points
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In this lesson we will learn how to create Lofts

Creating Simple Lofts

•Creating Simple Lofts
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A Loft can be a Positive (add material) or Negative 
(substract material) solid that is generated by two or 
more planar sections swept along a spine

What is a Loft ?

The Planar sections can be connected with Guide Lines

Be aware Closing Points on the sketch must be aligned to get the 
proper orientation of the sections otherwise the loft would be 
twisted

Directional arrows are provided to get the proper orientation of 
the Loft

Guide Line

Closing Point
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 Lofts can be used for several reasons.
• To create complex solids. 
• Or to create some transition geometry between two 
existing solids in a part

When Should we Use Lofts and Removed Lofts ?

Removed Lofts are used the same way when you wish to subtract 
a transitioned surface from another solid



Copyright DASSAULT SYSTEMES 2002 36

Loft Creation : Guide Lines

(1)

1 Select the Loft icon

2 Select the sections the loft is going to pass 
through. The order in which you select the 
sections is important, it will define the order 
of connection between the sections

(4a)

The loft is passing through the 
sections and it is limited by the 
guide lines

(2a)

(2b) (2c)

3 Select the Guide option from the 
dialog box

(3)

4 Select the Guide lines

(4b)

(4c)

(4d)

5 Select OK

(5)
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Loft Creation : Spine 

(1)

1 Select the Loft icon

2 Select the sections the loft is going to pass 
through. The order in which you select the 
sections is important, it will define the order 
of connection between the sections

(4)

From the first to the last section, the solid is 
generated  by doing a sweep along the spine. The 
sections always stay fix in space 

(2a)

(2b)
(2c)

3 Select the Spine tab from the dialog 
box(3)

4 Select the Spine

5 Select OK

(5)
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Loft Creation : Closing Point and Orientation 

Orientation of the section

When selecting another section, it might happen that the 
section is orientated in the other direction than the 
previous one, so, to reverse the section orientation select 
the arrow which indicates the section orientation

Closing point of 
the section

To change the 
closing point of a 
section, select 
another point on this 
section
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Loft Creation : Tangent Surfaces 

1 Select the first section 2 Select the surface 
(corresponding to the first 
section) the loft will be 
tangent to

3 Select the intermediary 
sections

4 Select the last section 5 Select the surface 
(corresponding to the last 
section) the loft will be 
tangent to

6 Validate

You get :

Result with the same 
sections but without any 
tangent surfaces

(1) (2) (3) (4) (5)



Copyright DASSAULT SYSTEMES 2002 40

In this lesson we will learn how to create Remove Lofts

Remove Lofts

•Creating Simple Remove Lofts
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The Remove Loft capability generates lofted material, by sweeping one 
or more planar section curves along a computed or user-defined spine, 
and then removes this material. The material can be made to respect 
one or more guide curves

What is Remove Loft Material ?
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Remove Loft Material 

(1)

1 Select the Remove 
Lofted Material icon

2 Select the sections the loft is going to pass 
through. The order in which you select the 
sections is important, it will define the order 
of connection between the sections (You 
could have defined a spine or several guide 
lines, if no spine is selected, the system 
computes a spine for you)

(2a)

(2b)

(2c)

3 Select OK

(3)

(2d)(2e)
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Remove Loft Material : Closing Point and Orientation 

Orientation of the section

When selecting another section, it might happen that the 
section is orientated in the other direction than the 
previous one, so, to reverse the section orientation select 
the arrow which indicates the section orientation

Closing point of 
the section

To change the 
closing point of a 
section, select 
another point on this 
section
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Remove Loft Material : Tangent Surfaces 

1 Select the first section 2 Select the surface 
(corresponding to the first 
section) the removed loft will 
be tangent to

3 Select the intermediary 
sections

4 Select the last section 5 Select the surface 
(corresponding to the last 
section) the removed loft will 
be tangent to

6 Validate

You get :
Result with the same 
sections but without any 
tangent surfaces

(2) (1) (3) (4) (5)
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In this lesson we will learn how to use Coupling when creating 
Lofts

Coupling

•Coupling when Creating Loft
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A Coupling tab in the loft and remove loft functions to compute the loft using the 
total length of the sections (ratio) or between the vertices of the sections or 
between the curvature discontinuity points of the sections or between the 
tangency discontinuity points of the sections

What is Coupling when Creating Loft ?

Vertices, 
Curvature 
Discontinuity, 
Tangency 
Discontinuity

Vertices, 
Curvature 
Discontinuity

Vertex
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Coupling when Creating Loft 

1 Activate the Loft icon and select and orient the 
sections.

2 Select the Coupling tab from the 
dialog box 

A coupling tab in the loft and remove loft functions to compute the loft on the total 
length of the sections (ratio) or between the vertices of the sections or between the 
curvature discontinuity points of the sections or between the tangency discontinuity 
points of the sections

(2)

3 Select the desired kind of coupling 
from the combo

(1)

4 Select OK

(3)

(4)
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Coupling when Creating Loft : Ratio

1 Activate the Loft icon and select and orient the 
sections.

2 Select the Coupling tab from the 
dialog box 

A coupling tab in the “loft” and “remove loft” functions to compute the loft using the 
total length of the sections (ratio)

(2)

3 Select Ratio from the combo 

(1)

4 Select OK

(3)

(4)

The solid is passing through the sections and the variation between 
the sections is computed by a ratio corresponding to the length of 
each section

You get :
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Coupling when Creating Loft : Tangency

1 Activate the Loft icon and select and orient the 
sections.

2 Select the Coupling tab from the 
dialog box 

(2)

3 Select Tangency Discontinuities 
from the combo 

(1)

4 Select OK

(3)

(4)

The solid is passing through the sections and each section is split at 
each tangency discontinuity point. The solid is computed between 
each split section

You get :

A coupling tab in the loft and remove loft functions to compute the loft between the 
tangency discontinuity points of the sections
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Coupling when Creating Loft : Tangency then Curvature

1 Activate the Loft icon and select and orient the 
sections.

2 Select the Coupling tab from the 
dialog box 

(2)

3 Select Curvature Discontinuities 
from the combo 

(1)

4 Select OK

(3)

(4)

The solid is passing through the sections and each section is split at 
each curvature discontinuity point. The solid is computed between 
each split section

You get :

A coupling tab in the loft and remove loft functions to compute the loft between the 
curvature discontinuity points of the sections
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Coupling when Creating Loft : Vertices 

1 Activate the Loft icon and select and orient the 
sections.

2 Select the Coupling tab from the 
dialog box 

(2)

3 Select Vertices from the combo 

(1)

4 Select OK

(3)

(4)

The solid is passing through the sections and each section is split at 
each vertex. The solid is calculated between each split section

You get :

A coupling tab in the loft and remove loft functions to compute the loft between the 
vertices of the sections
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Coupling when Creating Loft : Points of Discontinuity 

These two points are 
tangency and curvature 
discontinuity points. They are 
also vertices 

This point is a tangency and 
curvature continuity point. 
This point is a pure vertex

To have a look at the different discontinuity, 
we have sketched a profile as shown below :

These are the different kinds of points that CATIA can use to split the sections when 
creating lofts using coupling

Segments 

Two 
arcs

These two points are 
curvature discontinuity 
points. They are also 
vertices
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Loft: Manual Coupling (1/2)

Activate the Loft icon select the 
sections and the guide curves 
(If necessary, change the 
section orientation) 

Double click in the 
Coupling field to display 
the Coupling window 

1 2

3

Select the Coupling tab then set 
the Sections coupling to Ratio

When the sections of the lofted solid do not have the same 
number of vertices you may define a manual coupling instead 
of changing or creating closing points

You get:

Section1

Section2

Section3 Guide1

Guide2

Guide3
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Loft: Manual Coupling (2/2)

For each section select the vertex to be taken into account in the coupling. You can 
visualize the coupling curve if the corresponding option is checked. The Vertices 
selection must be done in the same order than the sections selection

4

5 Click OK to end lofted surface 
definition

When the sections of the lofted solid do not have the same 
number of vertices you may define a manual coupling instead 
of changing or creating closing points

You get:

Note:To refine the shape of the lofted 
surface you can define another coupling 
curve : select the first coupling and click on 
the Add button, then define the new 
coupling curve as explained above.

a b

c

Note: This is also possible with the Remove 
Loft command
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Manual Coupling: Displaying Uncoupled Points

On this loft, the sections have not the 
same number of vertices and have some 
discontinuity in curvature and tangency

For each coupling mode, the points that could not be coupled 
are displayed in the geometry with specific symbols

For each coupling mode, 
the points that could not be 
coupled are displayed in the 
geometry with specific 
symbols

Tangency mode : uncoupled 
tangency discontinuity 

points are represented by a 
square

Tangency the Curvature 
mode : uncoupled 

tangency discontinuity 
points are represented by a 

square. Uncoupled 
curvature discontinuity 

points are represented  by 
an empty circle

Vertices mode : uncoupled 
vertices are represented by 

a full circle
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Loft: Relimitation (1/3)

When the limitation option is checked, the loft is 
limited to the start or (and) end sections even is 
a larger spine or guide curves have been used

By default the lofted surface is limited by the start and end 
sections. However you can choose to limit it on the spine or 
on the guide lines extremities

Note: This is also possible with the Remove Loft 
command
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Loft: Relimitation (2/3)

When the limitation option is unchecked, and 
when a spine has been used, the loft is limited 
by the spine extremities

By default the lofted surface is limited by the start and end 
sections. However you can choose to limit it on the spine or 
on the guide lines extremities

Note: This is also possible with the Remove Loft 
command
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Loft: Relimitation (3/3)

When the limitation option is unchecked, and 
when guide lines have been used, the loft is 
limited by the guide lines extremities

By default the lofted surface is limited by the start and end 
sections. However you can choose to limit it on the spine or 
on the guide lines extremities

Note: This is also possible with the Remove Loft 
command

Note: If a spine an guide lines have been used 
the loft will be limited on the shorter line
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In this lesson we will learn how to change the closing point when 
creating a Loft

Changing the Closing Point

•Changing the Closing Point
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When selecting the sections to create a loft (or remove loft), you can change the 
closing point after the selection of the sections and you can create a closing 
point anywhere on a section profile

What is Changing the Closing Point when Creating Loft ?
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Changing the Closing Point when Creating Loft (1/6) 

1 Activate the loft icon and 
select the first section

2 Select the second section 

(2)

3 Select the third section 

(1)

(3)
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Changing the Closing Point when Creating Loft (2/6) 

4 Click on Section2 
(Label)

5 Select Replace Closing 
Point from the 
contextual menu, then 
select a new closing 
point (5)

(4)

(7) (5)

7 Select Replace 
Closing Point from 
the contextual menu, 
then select a new 
closing point (7)

(6)

8 Select the arrows to reverse 
Section2 and Section3 

(8)

6 Click on Section3 
(Label) 
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Changing the Closing Point when Creating Loft (3/6) 

9 Check that the coupling is at 
Ratio then Select Apply in 
the dialog box

You can see that the solid is twisted because the default 
closing point of Section1 is not aligned with the closing 
points of the other sections 

(9)
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Changing the Closing Point when Creating Loft (4/6) 

10 In order to create a closing point on 
Section1, select the Section1 label with 
MB3, then select Remove Closing Point

(10)

A new dialog box corresponding to a point 
creation on a curve appears 

(11)

The point appears in blue before validation 

11 Then again, select Create Closing 
Point from the contextual menu
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Changing the Closing Point when Creating Loft (5/6) 

12 Select the Distance on curve 
option 

(12)

(14)

13 Select the Geodesic option 

14 Enter 100 as the Length 

(13)

15 Select OK 

(15)
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Changing the Closing Point when Creating Loft (6/6) 

16 Select the Coupling tab 

(16)

(18)17 Select Vertices option from the 
combo

18 Select OK

(17)

You get :
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You will learn more about 3D Wireframe Elements and how 
we use them to help construct our Part

3D Wireframe Elements

•3D Wireframe Elements
•Use of Wireframe Elements in Part Design
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What are 3D Wireframe Elements ? 

In the Part Design Workbench, we can create points, lines and planes without using the Sketcher. 
These elements belong to the “Reference Element” toolbar.

In the Specification Tree, they are inserted under “Open_Body” which contain all 3D Wireframe 
elements.

Even if these elements are some Wireframe Elements, we can use them with the Part Design Tools.
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A dialog Box is 
displayed

2

In Reference 
Toolbar, select 
Point by clicking 
on icon

1
Notice that we can 
choose between several 
types of points

3
The created point 
appears under 
Open_Body

We create the desired point

Creating 3D Wireframe Point
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A dialog Box is 
displayed

2

In Reference 
Toolbar, select 
Line by clicking on 
icon

1
Notice that we can 
choose between several 
types of lines

3
The created line 
appears under 
Open_Body

We create the desired line

Creating 3D Wireframe Line
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A dialog Box is 
displayed

2

In Reference 
Toolbar, select 
Plane by clicking 
on icon

1
Notice that we can 
choose between several 
types of planes

3
The created plane 
appears under 
Open_Body

We create the desired plane

Creating 3D Wireframe Plane
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Using 3D Wireframe Elements to Create a 3D Curve

1
You can create points in space according to their 
coordinates by using the Points tool from the 
Reference Element tool bar

2

Create the 3D curve by using the Curve in Space 
tool from the Free-Style Workbench

This curve can now be 
used to extrude a rib or 
create a slot
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We will learn how to use all of the various types of Surfaced 
Based Features Split, Thick Surface, Close Surface and 
Sew Surfaces

Surface Based Features

•Split
•Thick Surface
•Close Surface
•Sew Surface
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There are four Surface Based Features
What is a Surface Based Feature and when Do You Use It (1/2) ?

 Thick Surface: Used to create solids 
from surfaces.  Material can be added 
from either or both sides of the surface

 Split:  Used to split a solid with either a plane 
or a surface.
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There are four Surface Based Features
What is a Surface Based Feature and when Do You Use It (2/2) ?

 Sew Surface:  Used to glue a surface 
feature to an existing 3D solid.

 Close Surface:  Used to take a closed surface 
and turn it into a solid.
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Split 

1 Select body to be split 2

Select splitting element3

You can split a body with a plane, face 
or surface.  A typical use is where 
internal structure must be trimmed 
and associated to an outer 
aerodynamic shape to allow rapid 
future change

 Select Split icon

an arrow pointing to 
material to keep 
appears.  Click to 
change direction if 
needed
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Thick Surface 

1 Select surface to be thickened 2

Modify thickness 
offsets3

The resulting feature does not keep the color of the 
original surface

Select Thick 
Surface icon

and the preview shows the corresponding upper and 
lower thickness
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Close Surface 

1 Select Close Surface icon

2

Closed Surface appears in 
specification tree

3

Select surface to 
be closed
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Sew Surface 

1 Select the object to sew surface to 2

Select surface to sew3

Sewing means joining together a surface and a body. 
This capability consists in computing the intersection 
between a given surface and a body while removing 
useless material

Select Sew Surface icon

an arrow pointing to material 
to keep appears.  Click to 
change direction if needed
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Advance Draft

In this lesson we will see the Advanced Draft command

•Advanced Draft
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Select the View -> Toolbars -> Advanced 
Draft command to get the Advanced Draft 
toolbar 

The Advanced Draft command lets you draft basic parts or parts with reflect lines but it also 
lets you specify two different angle values for drafting complex parts. This task shows you 
how to draft two faces with reflect lines, and this by specifying two different angle values 
and by using both modes available.

What is the Advance Draft Command ? (1/5)

By default, the Advanced Draft toolbar is 
not accessible from CATIA, so in order to 
get it, you will have to select Views -> 
Toolbars -> Advanced Draft

You will see the following toolbar:
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With the Advanced Draft command, you can define if you want to draft both sides or not and 
if you want to draft with reflect lines or not. To do so, you will have to activate one or two 
buttons as described hereafter

What is the Advance Draft Command ? (2/5)
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The 1st side tab is used to define the characteristics of the draft angle for the selected faces. 
If you have decided to draft both sides, you will have to define the draft angle characteristics 
for the second side using the 2nd side tab. When drafting both sides with reflect lines, you 
can decide to get the draft angles independent or not

What is the Advance Draft Command ? (3/5)

To define the 
Faces to be drafted

To define the 
neutral element

To define the 
pulling direction

To define the draft 
angle value

To define if the 
angle are the same 
or not when 
drafting both sides
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To define the Parting Element, you will have to used the parting tab. The parting Element 
can be a plane, a surface or a face

What is the Advance Draft Command ? (4/5)

To define the 
parting element



Copyright DASSAULT SYSTEMES 2002 85

When you have decided to draft both sides with independent angle, you have to define the 
second side characteristics

What is the Advance Draft Command ? (5/5)

Neutral element

To define the 
pulling direction

To define the draft 
angle value

To define if the 
angle are the same 
or not when 
drafting both sides
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Advanced Draft Angle: Draft Both Sides (1/9) 

Select the Advanced Draft 
icon

1

You are going to see how to draft both sides using the Advanced Draft icon

Activate these two buttons2
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Advanced Draft Angle: Draft Both Sides (2/9) 
As the object to be 
drafted, select this face

3
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Advanced Draft Angle: Draft Both Sides (3/9) 

Select the No Selection option from the 
Neutral Element combo, then select the 
indicated plane

4
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Advanced Draft Angle: Draft Both Sides (4/9) 
Enter 21 in the angle field5 Select the parting tab6
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Advanced Draft Angle: Draft Both Sides (5/9) 
Select the Parting Element 
button

7 Select the Parting Element 
field

8
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Advanced Draft Angle: Draft Both Sides (6/9) 

Select the indicated plane9

Select the 2nd side tab10
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Advanced Draft Angle: Draft Both Sides (7/9) 
Select the No Selection option from the Neutral 
Element combo, then select the indicated plane

11
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Advanced Draft Angle: Draft Both Sides (8/9) 
Enter 45 in the angle field12 Select Preview13
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Advanced Draft Angle: Draft Both Sides (9/9) 

Select OK in the dialog box14

You will see

You get:
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We will see how to add material on a selected face by 
defining a thickness

Thickness

•Thickness Creation
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Thickness 

1
Multi-select faces to be 
thickened

2 Modify thickness definition 
of material to add in the 
dialog box

3

A standard use of thickness is when material has to be 
added or removed before machining a part. Thickness 
captures the design intent and allows rapid change

Select Thickness 
icon 

Select the Other thickness 
faces field then select 
another face

4
Enter –5 in the Other 
thickness field then select OK5

You get:

–5mm
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In this lesson we will learn how to use all of the various 
types of Transformations

Using Transformations

•Using Transformations
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Transformation is the ability to move a body either by translating it along an axis, 
rotating it around an axis or moving it symmetrically around a plane

What is Transformation ?

Geometry cannot be duplicated using a transformation

 Transformations come in 3 types :
 - Translation along an edge
 - Rotation about an axis
  -Symmetry around a plane
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Transformations are useful when you have created some geometry and decide 
that it needs to be moved, or rotated into a specific position

When Should we Use a Transformation ?

Transformations can only be used on either the whole Part Body or an 
individual Body within the Part

 There are some cases where it would not be easy to 
create the geometry in the plane that it is needed in 
because it requires the use of geometry not in the plane.  
You can create the geometry in the wrong plane and then 
rotate or translate to its proper position
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Translation

4

1

Select OK

Select the 
Translation icon

Enter the amount of 
translation or drag the 
icon, then select OK

You can also define the direction using 
the contextual menu on the Direction field

3
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Select the Rotation icon
Select an edge for 
rotation axis...

…and enter the 
amount of rotation or 
drag the icon

Rotation

1

2

You can also define the axis using the 
contextual menu on the Axis field

Select OK3
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Select OK

Select  plane defining 
the symmetry

Select the Symmetry icon

Symmetry

1

2

4

Instead of a plane, you 
can use a Point as the 
Reference element

Instead of a plane, you 
can use a Segment as the 
Reference element

You can also define the Reference using 
the contextual menu on the Reference 
field
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In this lesson we will learn how to use 3D constraints

3D Constraints

•Creating and Using 3D Constraints
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A 3D Constraint is the same as any other constraint only it is applied in the 3D 
model itself.  Basically you will note that some are reference type constraints and 
others are regular constraints. Creation is the same as in the sketcher, so we will 
concentrate on their usage here

What is a 3D Constraint ?

Normally, 3D constraints are modifiable and can be linked and driven as 
others are in the sketcher

 They are reference because there are general 
other constraints in the sketcher or implicit to 
the geometry that are constraining the 
geometry

 Reference constraints are shown in 
parenthesis and cannot be modified
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They can be used whenever you have 3D geometry that you wish to link to some 
type of 3D datum plane or surface

When Do we Use 3D Constraints ?

You may also find it useful when you are using Copy and Paste to locate 
the pasted piece of Geometry from where you wish

They are also useful when you need to drive the location 
of a piece of geometry created earlier in the design from a 
piece of geometry created later in the model.  Thus this 
will limit some of the need to re-ordering of the part
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Creating 3D Constraints

1
Select the Constraint icon and create 
a constraint between the left side 
surface and the hole on the left side 
of the part

2

Note: The first dimension created was not a 
reference dimension. No Parenthesis were 
on the value.  The second dimension was a 
reference dimension because the hole is 
located with the sketch for the hole from 
the same or the right side edge

Now repeat the process from the same side to 
the hole on the left side of the part 
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Using 3D Constraints

1
We want to drive the location of Pocket.1 
from Hole.2 created after it in the tree

2

Modify the constraint indicated in red to 
25mm and the Pocket.1 is now driven 
from the Hole.2 location

3

 Create the two constraints shown 
below from the center line of Hole.2 to 
the edges of the Pocket.1

Note: This capability will allow you to 
drive location of features in the tree from 
features created after them without having 
to do re-location of features in the tree.
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You will learn how to create a local axis in order to define local coordinates

 

Local Axis
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It is possible to create a local axis in order to define local coordinates. For example, it is, 
sometime, easier to build a point by coordinates in a local axis rather than creating it in the 
absolute coordinates system 

What is a Local Axis ?

Point created in the local 
coordinates system
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Local Axis : Creation
It is possible to create a local axis in order to define local coordinates. For example, 
it is, sometime, easier to build a point by coordinates in a local axis rather than 
creating it in the absolute coordinates system

Select the Axis 
System icon

Select the local axis 
origin point

(2)

Select the OX direction

Select the OY direction

You get :

(3)

(4)

Select OK in the dialog 
box

(5)

5

4

321
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Local Axis : Use
It is possible to create a local axis in order to define local coordinates. For example, 
it is, sometime, easier to build a point by coordinates in a local axis rather than 
creating it in the absolute coordinates system

Set the axis system As  the 
Current one with the 
contextual menu You get :

Using the Point function (Coordinates options), create 
a point with X=0, Y=0 and Z=100

(1)

1

2
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Customizing Local Axis (1/3)
Check Create an Axis System when creating a new part if you wish to create a three 
axis system which origin point is defined by the intersection of the default planes 
that is plane XY, plane YZ and plane ZX

Select Tools -> Options1
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Customizing Local Axis (2/3)

In the Options dialog box, select Mechanical Design -> 
Part Design then the Part Document tab

2

Select the Create an Axis 
System when creating a 
new part option

3

Select OK4
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Customizing Local Axis (3/3)

Double click on Part in the dialog 
box

5

Select the File -> New 
command

6

The local axis is 
automatically created:
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Additional Information
Local Axis dialog box

To expand the 
dialog box 

To shrink the 
dialog box 

To define the axis system origin 

To define the OX axis

To define the Oy axis

To define the Oz axis

To reverse the OZ axis

To reverse the OY axis

To reverse the OX axis
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Text with Leader
Flag Note with Leader

Annotation

You will learn how to attach a text to a part and how to add hyperlinks to 
your document and then use them to jump to a variety of locations
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You will learn how to attach a text to a part
 

Text with Leader
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A text with leader can be attached to a part in order to give information for example on surface 
treatment. This text can appears on the drawing

What are Texts with Leader?

Text

Leader
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Select the Text with 
Leader icon

Texts with Leader

1 Select the position of the 
leader on the part2 Enter the text in the dialog box 

then select OK
3

Place the text and the leader by 
dragging the arrow or the square 
points

4

You get:



Copyright DASSAULT SYSTEMES 2002 120

Double click

Additional Information

To Modify the text of a text with leader, double click on the text, you will recover the dialog 
box where you can change the text

Using the Properties command from the contextual menu will give you access to text, font 
and graphic modifications
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You will learn how to add hyperlinks to your document and then use them to jump 
to a variety of locations
 

Flag Note with Leader
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A flag note with leader can be attached to a part in order to give information for example on 
surface treatment. This flag is an hyperlink that can start any documents such as a 
presentation, a Microsoft Excel spreadsheet or a HTML page on the intranet

What are Flag Notes with Leader?
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Enter Part Process in the Name 
field

Select the Flag 
Note with Leader 
icon

Flag Notes with Leader (1/2)

1

Select the position of the 
leader on the part2

3
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Flag Notes with Leader (2/2)

You get:

Place the text and the leader by 
dragging the arrow or the square 
points

5

Select the Browse button then 
select the file to which you want to 
be linked then select OK 

4
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Select the Go to button in the 
dialog box 

Double click on the 
flag

Using Flag Notes with Leader

1

Select the Link in the dialog 
box2

3

The linked file is now started 
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Additional Information

To Modify the text of a flag note with leader, double click on the text, you will recover the 
dialog box where you can change the text

Using the Properties command from the contextual menu will give you access to text, font 
and graphic modifications

Double click

You can have several files linked to a flag note
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Analysis

You will learn how to analyze part in order to display the threads and tap,  
and to check if a part can be removed from mold in accordance with its 
draft angles

Analysing Threads and Taps
Draft Analysis
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You will learn how to display and filter out information about threads and taps 
contained in a part

 

Analysing Threads and Taps
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When a part has been created with threads and taps, CATIA does not physically displays these 
features. There is a way to quickly know all the information about threads and taps by using the 
Thread and Taps Analysis icon

What is the Threads and Tap Analysis ?

•You can display the threads or the taps or 
both of them 

•You can display the threads and taps 
numerical values

•You can display threads or/and taps of a 
given diameter value
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Analysing Threads and Taps (1/2)
You can display and filter out information about threads and taps 
contained in a Part 

Select the Tap – Thread 
Analysis icon

Expand the dialog box 
using the More button

1

2

Select the criteria that will define the 
types of threads and taps that will 
be displayed

3

To show the threads 
or taps geometry 

To show the 
threads or taps 
values To show diameters 

with a given value

To show taps

To show threads
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Analysing Threads and Taps (2/2)

Select Apply in the dialog 
box

You get:

4
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You will learn how to analyze the draft angle on the surface of a part 

Draft Analysis
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The Draft Analysis command lets you analyze the draft angle on the surface of a part. You will 
be able to detect if the part you drafted will be easily removed from the associated mold

What is the Draft Analysis ?

This type of analysis is performed based on color ranges identifying zones on the analyzed 
element where the deviation from the draft direction, represented by the normal to the surface at 
a given point, corresponds to specified values

The cursor manipulation for colors is limited to -20 
and 20 but the analysis is performed between -90 
and 90 degrees.

To get a result, the view mode must 
be turned to Material display
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The Draft Analysis command lets you analyze the draft angle on the 
surface of a part. You will be able to detect if the part you drafted will be 
easily removed from the associated mold

Select the Draft Analysis 
icon

1

Draft Analysis (1/2)

Drag the red point of the Compass and drag it onto a face 
perpendicular to the direction of extraction

2
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Select the Invert analysis direction in the dialog box 

Draft Analysis (2/2)
2

You get: 

Everything in green is correct 

Everything in red is incorrect 

You have to take care of the light blue faces but it might correct

You have to take care of the dark blue faces because it is certainly incorrect
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Additional Information
Draft Analysis dialog box

You can customize these 
colors by double clicking

To smooth the 
analysis 

To fix a direction of extraction, uncheck the 
Locked direction option, and select a direction 
(a line, or a plane which normal is used), or use 
the compass manipulators, when available 

If you move the pointer over the 
green arrow (Normal), the inverted 
normal is displayed in dotted line 

Circles are displayed indicating the 
plane tangent to the surface at this 
point 
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Measure, Mean Dimensions, Scan, Parents-Children
Cut, Paste, Isolate, Break
Inserting and Managing Bodies
Multi-Model Links
Sketch Selection with Multi-Documents Links
Scaling

Part Management

You will learn Part Management tools that you will need to design complex 
parts and integrate these parts into a Multi-model Environment
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In this lesson, you will see how to measure angle and distance between geometrical 
entities, then how to replay the construction history of a part and isolate temporarily 
any feature to work locally, then to provide an accurate view of genealogical links 
between elements. We recommend you to use it before deleting elements 

Measure, Mean Dimensions, Scan, Parents-Children

•Measuring Elements
•Mean Dimensions
•Scanning a Part
•Parents-Children Relationship
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Measuring Elements means to get the angle and the distance between two 
geometric entities

What is Measuring Elements ?

Results

Elements to be measured
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Measuring Elements

1

2 Set the desired type of Measurement 

Select  the Measure 
Between icon

3 Select your reference 
(1) and target (2) 
elements

4 Minimum distance and angle (if you customize your dialog box) are displayed 
on the geometry and in the results Window
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When creating dimensional constraints, you can define a tolerance. Using the 
Mean Dimensions icon you can compute the mean dimensions and the part will 
be updated. This can be useful for a part to be machined

What are Mean Dimensions?

Dimension with a 
Tolerance

Mean dimension
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Mean Dimensions (1/4)
1

2 Double click on the indicated dimension 

We are going to add tolerances on dimensions 
which have been created in the sketch of the 
shaft. Double click on Sketch.1
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Mean Dimensions (2/4)
3 4 In the appearing dialog box, enter 0.2 in 

the Maximum tolerance filed and enter 
0.1 in the Minimum tolerance field then 
select OK

Using the contextual menu on the Value field, 
select the Add Tolerance command 

5 The tolerance is created. Select Ok in the 
Constraint Definition dialog box then 
Exit the sketcher Dimension with a tolerance
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Mean Dimensions (3/4)
6 7 Select OK  To compute the mean dimensions, select the 

Mean Dimension icon

8 Select the Update All 
icon  

If you look at the dimensions in 
Sketch.1, you will see that they are 
changed to their means. The part is 
also updated  
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Mean Dimensions (4/4)
9 10 Select OK  To come back to nominal dimensions, select the 

Mean Dimension icon

11 Select OK  

12 Select the Update All 
icon  

If you look at the dimensions in 
Sketch.1, you will see that they are 
changed to their nominal size. The 
part is also updated  
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Scanning a part means to replay the construction history of a part and isolate 
temporarily any feature to work locally

What is Scanning a Part ?
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Scanning a Part
1

2 Use the Scan tools to navigate through the part 
structure

Select  Edit > Scan ... Menu option

Backward: goes to the previous feature in the tree 

Forward: goes to the next feature in the tree

Starting feature: feature active when starting scanning

Last feature: last feature in the tree

Exit: when you exit the active feature becomes in work (it is 
underlined in the tree)

Initial part
The Mirror.1 feature is in work: you 
can make local changes

3
4

To work again on the 
whole part, click the 
last feature in the tree 
and select the Define 
in work option in the 
contextual menu 
(MB3)
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The parents-children relationship provides an accurate view of genealogical links 
between elements. We recommend you to use it before deleting elements

What is Parents-Children Relationship ?

parents

children

Pad 1
Pad 2

Pad 3
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Pad 1

Parents-Children Relationship

2 Select  the Parent-Children 
option

3

Activate the contextual 
menu on the desired feature 
(here, Pad.1)

1

The graph allows you to show all parents / children (MB3)
Double-click a component to show/hide parents or 
children

parents

children
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Parents-Children (Edition) (1/2)

Select the Parent/Children command 
from the contextual menu

Parent Children command lets you edit features 

1

2 You get:
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Parents-Children (Edition) (2/2)

Select the Edit command from the 
fillet contextual menu

Modify the fillet radius then select OK

3

4

You get:5
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In this lesson, you will see how to cut or copy a feature and paste it onto a body and 
you will also see how to isolate or break 3D geometry from their parents 

Cut, Paste, Isolate, Break

•Cut/Copy and Paste (Drag and Drop)
•Isolate/Break
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Cut/Copy then Paste captures the node specified into the clipboard and either replaces (Cut) or 
copies (Copy) the content into a different selected point in the part structure. The action is 
interpreted by the system in a context sensitive manner. For example, if a pad is copied onto a 
different sketch, the new sketch is used for the profile and information on extrusion limits will 
be those of the pad. However, if pad1 is copied onto pad2, since this action has no real 
meaning, it is interpreted as generically copying the clipboard’s content into the part. The effect 
is to create another copy of pad1 (with its original sketch) in the part structure. This copy will be 
placed after whatever node is currently the “In Work” node

What is Cut/Copy and Paste (Drag and Drop) ?

Cut/Copy then Paste an be achieved by drag and drop. If the CTRL key is pressed during the 
drag and drop, the action is interpreted as a copy
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One way we 
can copy the 
limits of the 
circular pad to 
apply to the 
rectangular pad 
is to work 
within the Part 
tree and use the 
3rd. Mouse 
button to Copy 
Pad.2 and Paste 
onto Sketch.3

Another variation 
for the fillet - 
Keeping the CTRL 
key pressed, Drag 
with the 1st. Mouse 
button to one of the 
base edges of the 
rectangular pad 

We can copy the draft by using 
another variation - 3rd. Mouse button 
to copy Draft.1 from the tree then 
select a vertical face on the 
rectangular pad and 3rd. Mouse 
button to Paste

Cut/Copy and Paste (Drag and Drop)

2

3

1
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Isolate is used when 3D geometry is projected into a sketch in order to be modified and used as 
part of the sketch’s profile. Isolate duplicates the element since the original element cannot be 
changed since other geometry depend on it

What are Isolate and Break ?

Break is used to divide an isolated element into two parts at a specified point (usually to use 
one side of this element in the sketch)
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Using the Trim and Break icon in the 
sketcher, modify the sketch as follows, 
then exit the sketcher

Starting with the geometry 
below, we want to add a pad 

Isolate, Break (1/3)

21

Lines

Added pad 

Diameter 100

Pad

Intersection between the 
pad and the sketch plane

Diameter 50

Create a pad with 
an length of 20

3
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Edit the Sketch of the 
first pad then change 
the circle diameter to 50

Select the Undo icon (may be 
several times) in order to come 
back to diameter 100

Exit the sketcher (Sketch.1) then, if necessary, Update 
the part. You will get:

Isolate, Break (2/3)

5

6

4

Edit Sketch.2, then place the cursor on the yellow line then 
select Isolate from the contextual menu

7
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Create two Coincidence between the 
isolated arcs and the cylinder then exit 
the sketcher

Exit the sketcher then, if necessary, 
Update the part. You will get:

Edit the Sketch (Sketch.1) of 
the first pad then change the 
circle diameter to 50

Isolate, Break (3/3)

9

10

8
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You will learn ways to manage Bodies using tools such as Assembling, Intersecting, 
Adding, Removing, and Trimming bodies

Inserting and Managing Bodies

•Inserting a Body
•Assembling/Intersecting/Adding/Removing Bodies
•Union Trimming Bodies
•Removing Lumps
•Replacing a Body
•Change Boolean Type
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Using several bodies in a part allows you to design different step of a part without any 
operations between bodies. You will be able to perform operations (add, assemble, remove, …) 
later. This method can be use when, for example, you create a mold part. You can create the 
outside of the part in a body and the core in another one then you can remove the core from the 
main part. Later it will be easy for you to separate the part and it core

What is Inserting a Body?
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A body is added in 
the tree

In order to insert a Body, 
select the Insert -> Body 
command

Inserting a Body

2

1

You can work in the PartBody or in 
Body.2. Top Switch from one Body to 
another, select the Define in workobject 
command from the contextual menu of 
the desired body
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Assembling/Adding : If Body2 is Assembled or Added to Body1, the operation between the 
bodies is a Union.  The only difference between the two is that Assemble will respect the 
“nature” of features.  If Body2 contains as its first node a Pocket feature (permissible), 
Assemble will see it as a Pocket and remove material from Body1.  In this case, if Add is used, 
the Pocket will be seen by Body1 as a Pad

What is Inserting and Managing Bodies ?

Intersecting : The resulting material is the intersection between 
the two bodies

Removing : If Body2 is Removed from Body1, the operation is 
Body1 minus Body2

Union Trim : The Union Trim is basically a Union with an option to 
remove or keep one side or the other.  In the picture on the right, the 
purple face is selected to remove the right side and the blue face is 
selected to keep only the top side.  For the Union Trim to work, the 
geometry must have sides that are clearly defined

Remove Lump : All the above options work between two bodies.  
The Remove Lump works on geometry within a specific Body.  If a 
single Body has material that is completely disconnected, each 
piece of disconnected material is defined as a “Lump”.  The user can 
delete any Lump as a single entity even if the Lump is a combination 
of numerous features
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With the cursor on Body.2, select 
Assemble from the contextual menu 
(MB3)

We want to assemble Body.2 
with PartBody 

Assemble 2

1

You get:Body.2 contains a 
groove

Because Body.2 contains a 
groove which is a feature that 
removes material, the result of 
the assemble operation is also 
removing material

Select OK in the Dialog box3
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With the cursor on Body.2, select Add 
from the contextual menu 
(MB3)

We want to add Body.2 with 
PartBody 

Add 2

1

You get:
Body.2 contains a 
groove

Body.2 contains a single groove, 
so it is appears as a solid (even if it 
normally removes material). When 
you Add a Body, CATIA keeps the 
feature like it appears before the 
addition.

Select OK in the Dialog box3
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With the cursor on Body.2, select 
Remove from the contextual menu 
(MB3)

We want to remove Body.2 
from PartBody 

Remove 2

1

Select OK in the Dialog box3

You get:
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Intersect

We want to intersect Body.2 
with PartBody 

1

With the cursor on Body.2, select 
Intersect from the contextual menu 
(MB3)

2

Select OK in the Dialog box3

You get:
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Union Trimming Bodies

We want to do an Union Trim 
of Body.2 with PartBody 

1

With the cursor on Body.2, select Union 
Trim from the contextual menu 
(MB3)

2

Select the Face to remove then the face 
to keep (Activate the corresponding 
field before in the dialog box)

3

You get:

Select OK4
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Removing Lumps (1/3)

Cavity 

After certain operations, it may happen that some Lumps or Cavities appear in the 
part. We need to remove them. The Remove Lump command allows you to remove 
Lumps and Cavities

Lumps 
Shell 

Pockets 
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Removing Lumps (2/3)
With the cursor on PartBody, select Remove 
Lump from the contextual menu (MB3) 

1

Select the Faces to remove field in the dialog 
box 

2

Select the two following faces belonging to 
the lumps to be removed

3
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Removing Lumps (3/3)
In order to select a face of the cavity, place 
the cursor on the cavity to be remove then 
press the Up arrow key on the keyboard 

4

Using the small arrows, highlight one of the 
cavity face

5

To confirm the face selection select the circle6

Select OK7

You get:
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Assembling a Set of Bodies (1/3)
Assembling a set of bodies (Multi selected via the 
Ctrl key) is possible

Using the Ctrl key, select 
the three following 
bodies to be assembled

1
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Assembling a Set of Bodies (2/3)

With the cursor placed on the last body, select the 
Assemble command from the contextual menu2
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Assembling a Set of Bodies (3/3)

Select OK in the dialog box3

You get:
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You can replace a body use in an operation by another one
What is Replacing a Body?
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Select the Replace command 
from Body.3 contextual menu

Replacing a Body (1/3)

1Body to be 
replaced

Replacing 
body

Select Body.42
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Select the following line in 
the dialog box

Replacing a Body (2/3)

3

Select the following face. 
This face is the face that will 
be removed during the Union 
Trim operation

4

Select OK5
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If necessary, update the part 
by selecting the Update All 
icon

Replacing a Body (3/3)

6

You get:
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Change Boolean Type (1/4)
 The initial part is composed of three 
bodies. Assemble Body.1 to Part 
Body.

1

 Remove Body.2 from Assemble.1.You obtain 
Remove.1.

2
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Change Boolean Type (2/4)

 Click with the right button mouse on 
Remove.1. In the contextual menu, 
select Remove.1 object

3

 Choose now the new operation. For 
example, click on Change To 
Assemble.

4
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Change Boolean Type (3/4)

 You obtain :5

 Change now Assemble.2 to Union 
Trim. You obtain :

6
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Change Boolean Type (4/4)

 You can edit Trim.1. For instance, 
select the cylinder's top face as the 
face to keep. You obtain :

7
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You will learn ways to use Multi-model links to help propagate design changes 
 

Multi-Model Links

•Establishing Multi-Model Links
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The concept of working within an independent “Body” and then having the ability to Add, 
Remove, or Intersect this Body with our “Master” PartBody gives us this added modeling 
flexibility

What are Multi-Model Links ?

There are different ways that the independently modeled Body 
can be assimilated into the PartBody
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In a CATIA session you have two 
separate parts

Establishing Multi-Model Links (1/3)
1

Using the Contextual Menu, copy 
the PartBody of Part22

Place the cursor on the PartBody 
of Part1 then Select Paste Special 
from the contextual menu

3
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In the dialog box, select 
AsResultWithLink and the Paste 
button, then select OK

Establishing Multi-Model Links (2/3)

Part1 becomes:4

In Sketch.1 of part1, create a 
distance (10mm) between the 
circle and the copied cylinder then 
exit the sketcher

5

3



Copyright DASSAULT SYSTEMES 2002 186

Now, in Sketch.1 of part2, create a 
diameter constraint of 50 then exit 
the sketcher

Establishing Multi-Model Links (3/3)
Part1 becomes:7

With Part1 active, select the 
Update All icon

8

6

You get:
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Sketch Selection with Multi-Documents Links

It is now possible to copy and paste with link a 
sketch from a document to another one 
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Sketch Selection with Multi-Documents Links (1/5)

After loading a part containing a 
sketch, start a new part using 
the File + New command

1

2 Display the two parts 
using the Window + 
Tile Horizontally 
command

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case of modification 
of the original sketch the document in which the copy is used will be also modified

You get:
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Sketch Selection with Multi-Documents Links (2/5)

With the cursor on Sketch.1 in 
the tree, select the Copy 
command from the contextual 
menu (MB3)

3 4 In the second part, place the cursor on 
PartBody, then select Paste Special 
from the contextual menu (MB3)

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case of 
modification of the original sketch the document in which the copy is used will be 
also modified
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Sketch Selection with Multi-Documents Links (3/5)

Select AsResultWithLink in the 
dialog box5 6 Expand Sketch.1 in order to see what 

has been copied (by selecting +)

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case of 
modification of the original sketch the document in which the copy is used will be 
also modified
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Sketch Selection with Multi-Documents Links (4/5)

Create a 20mm height pad using 
the copied sketch7

8 In the first part, modify the sketch as 
follows

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case of 
modification of the original sketch the document in which the copy is used will be 
also modified
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Sketch Selection with Multi-Documents Links (5/5)

To take the modification into account in the second part (the 
one which contains the copied sketch), place the cursor on 
Part2 then select the Part2object + Update All Links 
command

9

You can copy a sketch in a document then paste it into another document keeping 
the link with the first one. You can use this copied sketch and in case of 
modification of the original sketch the document in which the copy is used will be 
also modified

You get:
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As specified in Part document: The 
copied element can be modified 
and has no link with the original 
one. The original element is 
duplicated

AsResultWithLink: The copied 
element cannot be modify (it is a 
datum)but in case of modification 
of the original element, the copied 
one is updated

Additional Information

The different Paste Special options:
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 You will learn how to apply an affinity to a part with reference to a point

Scaling

•Scaling/Affinity
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A scaling is a part transformation which is calculated by selecting a reference point and by 
entering a ratio

What is Scaling ?

The system computes the distance between all the points of the outer skin of the part 
and the reference point, then these distances are multiplied by the ratio to get the new 
distances between the reference point and all the point of the new outer skin
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You can also resize a body in relation to a face or plane by 
selecting it instead of a reference point.  The body will scale 
with it.  You will obtain an affinity

Select the reference 
point

Select the Scaling icon Modify scaling ratio then 
select OK

Scaling/Affinity

2

31

You get:


